i>clicker Registration All-in-One

The i>clicker system may be used as a simple tool to give you instant, anonymous feedback in class, in
which case no registration is necessary. However, if you (like most instructors) want to go a bit further and
give credit to your students for class participation and/or performance, you will need to:

1. Associate each of your students with the unique serial number on their i>clicker remotes (i.e.

Registration).

2. Decide on the grading details for each session of your class (see Section 3 on i>grader).

Note: Students do not need to be registered in order for i>clicker to collect votes. For unregistered
students, responses will be stored in your course folder and associated with the unique serial ID number
on the student’s remote. After students register, all their previously recorded responses will be
retroactively assigned to them.
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g TIP You can elect to use i>clicker as a completely anonymous system, but you may have a difficult
time with student compliance if you don'’t assign even a few points for participation. We've found that
making i>clicker an option but not tying it to any points/grading results in very few students using i>clicker in
class.

Please take a moment to consider how you want to record i>clicker grades. Will you use a course
management system like Blackboard or Moodle? Will you use Excel or your publisher’s testing system?
The grade book you use will determine how you create a roster. Find your grade book on the following
flowchart and follow the instructions.



What gradebook will you use?

= Excel
 Publisher’s test bank
« Any gradebook or course management system that is not supported by i>clicker

« Blackboard (Versions 6, 6.3, 7, 7.3, 8)

« Blackboard Enterprise (formerly WebCT)(Campus Edition Versions 4, 6, 6.1, 6.2 and Vista, Versions 3 and 4)
* ANGEL (Versions 6, 7.1, 7.2, 7.3)

* Moodle (Versions 1.6, 1.8, 1.9)

» Sakai (Versions 2.4, 2.5)

* Desire2Learn

Create a roster using the below directions.

Do NOT follow the instructions below. We have course management system (CMS) specific documentation on the
“Documentation” link at www.iclicker.com . Please download and read the directions for your CMS via our documentation.

Do NOT follow the instructions below. We
have course management system (CMS)
specific documentation on the
“Documentation” link at www.iclicker.com.
Please download and read the directions for
your CMS via our documentation.

!

Registration:

Each student remote has a unique serial number printed on the back. This number is referred to as the remote
ID. The association (or registration) of a student with the remote ID is required before a student can receive
individual credit for voting in class. To register your students, you must first create a file containing student
information in your course folder. If you are not planning to integrate voting data with your course management
system (CMS), you will need to create a text file named Roster.txt. Please note that various Course
Management systems require different file names and types. Please refer to the CMS documentation on
www.iclicker.com for more information.

The Roster file must have one line for each student in your class, with each line containing the student’s Last
Name, First Name, and Student ID, separated by commas. The Student ID may be a college ID nhumber, email
alias, or any other easily readable text string—as long as it is guaranteed to be unique for each student. We
recommend that you use an ID number or naming convention that you currently use (personally or as required
by your institution) to record your students’ other grades, for easiest import of i>grader data into your course
grade book.


http://www.iclicker.com/
http://www.iclicker.com/

For PC Users: The Microsoft Notepad application (or any other plain text editor) can be used to easily create
this file. To create a txt file using Notepad:

1. Go to “Start” and select “Accessories.”

2. Open Notepad from the list of Microsoft Accessories.

3. You can type in the student information or Copy and Paste it from an existing roster (in Excel or any other
format) into Notepad.

4. Save this as “Roster.txt” within the folder you've renamed for your course. You will need to do this for each
section or course in which you are using i>clicker.

For Mac Users: The TextEdit.app application (or any other plain text editor) can be used to easily create the
Roster.txt file. To create a txt file using TextEdit:
1. Go to the “Applications” folder and open“TextEdit.”
2. Enter the student information, or Copy and Paste it from an existing roster file into TextEdit. Note: If you
copy/paste the file, you may still need to modify the contents so that each line contains student information
in the correct format.
3. Save this as “Roster.txt” within your course folder.

You will need to do this for each section or course in which you are using i>clicker. A sample Roster.txt file is
provided in your class folder. You may wish to simply edit this file rather than creating a new one.
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Adams, samantha, Student_0

Green, christopher, Student_1

smith, Thomas, Student_2

walker, sarah, student_3
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g TIP: You can avoid re-typing your entire roster by converting an Excel list of students to a .csv file, and then
convert the .csv file to a text file. The instructions below should help you create a roster.txt file using MS Excel.
Please let us know if you have any questions.

ADAPTING AND CREATING YOUR ROSTER FILE FROM EXCEL:

1. Open the roster file you received from your registrar in Excel (to do this, the file must be in either an XLS or CSV format)

2. Re-arrange your roster file columns. You only need three fields/columns for the i>clicker roster (last name, first name,



student ID). You will likely have other columns within your own registrar or school-provided roster file. Delete the extra
columns.

3. Re-arrange the columns to match the following format. Each student should occupy one row, and the columns should
contain the following data:

Column A: Last name

Column B: First name

Column C: Student ID

3. Click on the File menu and choose Save as.

4. Select CSV (comma delimited) as the file type.

5. Name the file roster and save it to your course folder.

Renaming the Roster.csv file:

1. In your course folder you may see two files; roster.csv and roster.txt.

2. If roster.txt is there, delete it or rename it (right click on the file, choose rename) to roster.old. (If roster.old already exists,
you'll need to delete that file first.)

3. Right click on the roster.csv file, and select “Rename.” Rename roster.csv to roster.txt.
After completing these steps you should have a properly formatted roster.txt file in your course folder that is all ready to go!
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g TIP for PC Users: SHOWING (and ELIMINATING) FILE EXTENSIONS

Occasionally, i>clicker users have had problems creating a roster.txt file because of hidden file extensions (e.g.
roster.txt.txt is accidentally and automatically created). Below are a few steps to make sure you are not facing t
his hidden file extension issue! These steps should only have to be completed once on a computer, unless the s
etting is otherwise changed.

1. Open your course folder.

2. Click on Tools >> Folder Options.

3. In the Folder options window, click on the View tab.

4. Look for the item in the list that says, "Hide extensions for known file types." It should appear directly bene
ath the section dealing with "Hidden files and folders." Make sure that this box is UNCHECKED.

5. Check your roster.txt file again. If you see that you have a hidden file extension, right click on the file and ren
ame it from roster.txt.txt to simply roster.txt.

g TIPS:

The most common registration mistake involves students entering the wrong student ID (as many
institutions have 1-3 different IDs). To avoid this mistake, please consider the following steps:
- Add i>clicker instructions to your syllabus so your students follow the proper registration protocol (and will
understand why they are purchasing the clickers). We have provided sample text below.
« Decide upon a policy for students who cannot or do not register their clickers successfully. Do you want
them to find you after class? In your office hours? Email you their remote ID and student ID for manual
registration? Inevitably, a small percentage of students will struggle with the registration process; to save
yourself aggravation, you may want to include some directions in your syllabus to anticipate this problem
and avoid a lot of manual work on your end.
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Sample Syllabus Inserts:

FOR ROLL CALL/in-class REGISTRATION:

"You are required to purchase an i>clicker remote for in-class participation. i>clicker is a response system that
allows you to respond to questions | pose during class; you will be graded on that feedback and/or participation.
In order to receive this credit, you will need to register your i>clicker remote in class. | will project a Registration
screen with 3 steps to follow (look for your [student ID], which will alphabetically scroll down the screen). Once
your remote is registered, your [student ID] will no longer appear on that scrolling list and you are registered for
the entire semester. If for some reason, you can't follow these steps, | will need to register you by [alternative
policy] by [date]. i>clicker will be used every day in class, and you are responsible for bringing your remote
daily." (Note to the instructor: [student ID] = the type of student ID that you have chosen to use, as noted in the
instructions in step #10.)

FOR WEB REGISTRATION:

"You are required to purchase an i>clicker remote for in-class participation. i>clicker is a response system that
allows you to respond to questions | pose during class, and you will be graded on that feedback and/or
participation. In order to receive this credit, you will need to register your i>clicker remote online within the first
[amount of time set by instructor] of class. You must have come to class at least once and voted on at least one
question, in order to complete this registration properly. Once you have voted on a question in my class, go to
www.iclicker.com/registration. Complete the fields with your first name, last name, student ID, and remote ID.
Your student ID should be [student ID]. The remote ID is the series of numbers and sometimes letters found on
the bottom of the back of your i>clicker remote. The i>clicker response system will be used every day in class,
and you are responsible for bringing your remote daily." (Note to the instructor: [student ID] = the type of student
ID that you have chosen to use, as noted in step #10.)

i>clicker offers you three straightforward registration options: an in-class option (for your entire class), a
manual option (for individual students), and an “online/web” option. Minimal information is required of
your students and all registration options are tied to your class roster. There are no site license or registration
fees for i>clicker software.

&,

In-class and online registrations are not mutually exclusive, and both can be used to register students in one
class. For a small class, roll call is recommended, while a combination (or on-line exclusively) is recommended
for larger classes.
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Option One (Recommended): Web Registration

Web registration is fast and easy (and done entirely outside of your lecture). Your students can also register
through a simple Web registration page. To do this, send your students to the following web site:
www.iclicker.com/registration.
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Once your students have arrived at the site, each student must:
1. Enter his/her First Name and Last Name in the appropriate fields.
2. Enter his/her student ID (the same one that is in your Roster.txt file)
3. Tip: When using Web registration, the key to success is deciding what student ID will be used and
sharing those directions with students before they register their clickers online. You may want to add
registration ID instructions to your syllabus so your students follow the proper registration protocol.
4. Enter his/ her i>clicker remote ID (this is the unique set of numbers and letters located on the bottom
of the back of their remote).
5. Enter the security/verification code that appears on the screen. This verification image will appear as
a slightly distorted series of numbers and/or letters (and is used to keep spam bots from submitting the
form).
6. Click “Enter.” The student will see an on-screen message confirming that registration was successful.
The student’s ID is now tied to his/her unique i>clicker remote ID.

Once your students have registered online, you will need to synchronize the relevant information from the Web
server with your i>grader application. This updates the student registration information in your class folder. This
is one of the functions built into i>grader, which is described in the next section.

Note: If a student has not voted with their i>clicker remote, the online registration will not synchronize with your
i>grader application. The student must vote at least once in class. As such, we recommend you ask at least one
clicker question (for example, an attendance polling question) on the first day of class to capture remote IDs
before requiring your students to register.

g TIPS

Students can use one i>clicker remote for multiple classes, and only need to register on the web once. If
the student makes a mistake they can simply register a second time.
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i>clicker offers institutions the option to host their own registration site or use their own LDAP
authentication with our national database; we can provide the requisite scripts and administration support. If



your institution has standardized on i>clicker, your registration may already be hosted locally. Check with your
administrator for more information. If you think locally hosted registration or authentication would be of interest to
your campus or department, contact us at sales@iclicker.com for details.

A certain amount of leniency is built into our Web Sync operation. If the student registered with slightly
different information, you will get the prompt to match the student manually to the roster. The information in your
roster overrides what is on the web. If the student entered completely different information on the web
registration form, then the entry will just be skipped as if he or she had never registered. The student just needs
to register again.

Option Two: In Class (or “Roll Call’’) Registration:

Roll-call registration needs only to be completed once (even if you spread out the process across a couple of
lectures) and is an in-class registration tool. We do not recommend using Roll Call for large sectionsof students.
Many of our users find it is an efficient and fast way to register students in smaler classes (100 or less).

To use Roll Call, your computer screen needs to be projected so all students can easily see it.

Open i>clicker by double-clicking the iclicker application icon in your course folder and selecting “start session”
from the Welcome Screen. From your floating menu bar, click on the down arrow to open the Options menu and
select “Loan/Register Clickers.”

From the Loan/Register Clickers window, select Roll Call.

@ sTART @ DISPLAY | |« . :
i Loan/Register Clickers
Question On The Fly
L AT Settings and Preferences
Remote :
Student : -
Register : For The Term {Permanent) ~

OK Cancel

The ROLL CALL screen will appear as below. Your student’s information (from the Roster.txt file you have
placed into your course folder) will begin scrolling as shown below:

The instructions for students to register are outlined on the screen and are easy to follow.

1. Step One: The student locates his/her name or ID as read from the Roster.txt file.

2. Step Two: The student must wait until his/her ID has scrolled down into the central blue region of the
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Step Two screen. A letter will then appear to the right of his/her ID or name. The student must press the
displayed letter on his/her i>clicker remote, at which point a second (different) letter appears to the right of
his/her name or ID.

3. Step Three: The student should press the second letter on their keypad to complete the registration process.

This is the final step in tying each individual student to his/her unique remote. Once the second letter is selected,
the boxes to the right of the name disappear and the student is registered for the duration of the course. His/her

name will no longer appear on the scrolling roster list.

In the example shown here, the student C Brown has pushed the first button and is now being prompted to push
the second button (letter D.) Once the student has pressed “D,” her student ID and her i>clicker remote ID/serial
number (#0028ECF, shown to the left of her name) will be tied together for the rest of the course.

If a student’s name scrolls off the screen before completing Steps 2 or 3, s/he should simply wait for his/her
name to appear again. Names will continue to scroll on the screen until you click on the Close button (on the
bottom right screen) or until all students have registered.

Register Your ixclicker
Scrolling pace: Q Slower @ Moderate © Faster

Step One:

Look for your Last Name,
First Initial Student ID

Stelzer, T. tstelzer
Hawk, T. thawk
Smith, J. jsmith
Brown, C. cbrown
Student, B. bstudent
Student, A. astudent

Step Two:

Press the LETTER next
to your ID/name to
REGISTER your i-clicker

Step Three:

Press the SECOND LETTER
next to your ID/name to
CONFIRM your registration

To CLEAR your
Registration, press “DD”

close




Register Your iclicker
Scrolling pace: O Slower @ Moderate (QFaster

Step One:

Look for your Last Name,
First Initial Student ID

Step Two:

Press the LETTER next ]

to your ID/name to Stelzer, T. tstelzer| A |

REGISTER your ilicker Hawk, T. thawk [ E |
Smil.ii, = j:mlil.hi D_'T

Step Three: #0028E7CF=Brown, C. cbrown [Jj (D)

Press the SECOND LETTER Student, B. bstudent

next to your ID/name to Student, A. astudent

CONFIRM your registration

To CLEAR your
Registration, press “DD"

close
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@ TIP: If a student accidentally registers his/her clicker to the wrong name, s/he should push the D button on
his/her i>clicker remote twice to clear the incorrect registration and restart the registration process.

Option Three -In Class “Individual’’ Registration:

If only a few students need to register (for example, a new student joins your class after you've completed Roll
Call registration), an individual registration option is available.

1. From the i>clicker floating menu bar, click on the down arrow to open the Options menu and select
“Loan/Register Clickers.” Be sure that “For the Term (Permanent)” is selected from the “Register” drop
down menu

2. Now enter the student’s Remote ID (the number on the back of the i>clicker). This can be done by
just typing it into the Remote field, or by having the student hold the On/Off button on his/her remote
until the blue light starts flashing (around two seconds) and pushing the A button twice. This will send
the clicker ID to the computer and the Remote ID will appear in the Remote field as if you had typed it.

3. Select the student’s ID from the drop down menu labeled Student. The names in this list are taken
from your Roster.txt file. Click OK. The student’s ID will be associated with the corresponding i>clicker
remote ID.

Remote : #OO2BETCF
Student : Jamith (Smith, Jana) b
Register : For The Term (Permancnt) ¥

oK Roll Call Cancel




The procedure described above permanently assigns the remote to the student. In the example above, Remote
ID 0028E7CF is permanently assigned to Jane Smith with ID jsmith.

Note: Only one student at a time can register via this option.
Loaning a clicker (Temporary Registration)

If a student forgets his/her i>clicker remote, you can loan one for a single lecture. To associate the loaned clicker
with a student for one lecture only, you should perform a temporary (or loaner) registration.

RT @ Loan/Register Clickers
Question On The Fly *

Settings and Preferences

D

To do this, follow the exact same steps as outlined above for an individual registration, BUT make sure to select
the “For one Session (Loan)” option from the Register drop down menu (as shown here).

Remote : #002BETCF
Student : Jsmith (Smith, Jane) -
Register : For The Term (Permanent) ;
For The Term (Permanent)
oK Roll Call Cancal ~One Session (Loan)

If this option is used, the assignment of the i>clicker remote ID is tied to that student for one lecture only. This
temporarily overrides any permanent registration. The student will receive credit for any votes during that lecture
and these will be synchronized with existing scores. In subsequent classes, the student can resume using
his/her regular clicker.

iI>clicker Troubleshooting Guide and Tips

The first step to solving a registration issue is to make sure your roster meets the guidelines below.

If you are NOT planning to integrate i>clicker voting data with a course management system:
0 You must have a roster file containing student information, saved in your i>clicker course folder. You
will need a separate file for each course folder you are using.
o The file must be a text document (with a .txt extension) and the file name must be “roster.”
o The file must contain each student’s last name, first Name, and Student ID. Each line of the roster.txt
file must contain information for one student, in exactly the format below:

Last Name, First Name, Student ID
0 The students’ information must be separated by commas (not tabs). If you saved a .txt file using Microsoft

Excel, the file is tab-delimited. To fix this, save the file in .csv format instead. Make sure you have file
extensions showing (the file name should appear as “Roster.csv,” not just as “Roster.”), then manually
change the file name from Roster.csv to Roster.txt.

If you are planning to integrate i>clicker voting data with a course management system:



0 You must download a course roster from your CMS Gradebook and save a copy of this file in your
i>clicker course folder. You will need a separate file for each course folder you are using.

0 The name and format of the file will vary depending on your CMS and version. You may need to
rename the file after it has been downloaded. Please refer to the table below for the appropriate name
and file type for each CMS supported by i>clicker.

CMS File Name File Type

Blackboard gb_export.csv Comma-separated
value

Blackboard Enterprise (formerly class.txt Text file

WebCT)

Angel gradebook.csv Comma-separated
value

Moodle MoodleRoster.txt Text file

Desire2Learn Gradesexport.csv Comma-separated
value

Sakai Sakaigradebook.csv | Comma-separated
value

o If you saved a new copy of the file when you renamed it, you may have altered the
formatting. Please download the file again. To change the file name, right-click on the
file and use the Rename option.

If you are sure the roster file is correct, please follow these steps to resolve most
Issues:
o Open i>clicker and click on Settings and Preferences. On the Registration/Export
screen, make sure that the setting you have selected for Roster/Export matches the
file you have placed in your course folder (e.g. if you are using Moodle, make sure
Moodle is selected rather than “General”).

o Have your students vote in class before attempting to use the Synchronize Web
Registration feature. Students’ registrations on the www.iclicker.com website will not be tied
to the information in your roster until the students have used their i>clicker remotes at least
once in your course.

o0 Run the WebUpdate program in your course folder, making sure to click “Check Next
Program” after updating i>clicker. The most recent versions of i>clicker and i-grader resolve
some issues related to web registration (especially if we have added new support for new
course management systems or upgrades).

o To save registration data, you must have full access to your i>clicker course folder,
and to all of the folders within it. Please verify that no folders or files are marked “Read-Only”
and that you are not restricted from writing or saving information in the location where you are
running the program. If your i>clicker course folder is on a network drive or if you are running
it from a school computer you may need to verify your permissions with your campus IT
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department.

If your students have registered on the web but you are having trouble getting their
registration info into your course:

If you

o0 Make sure that your students have registered using the same student IDs that you
have in your roster file. We recommend establishing a student ID convention for
your course and communicating it to students as soon as possible (you may want to
add this information to your syllabus).
* If you are using a CMS roster, the students should register with their CMS user
ID as the student ID.
« If you are using a roster.txt file that is not tied in anyway to your CMS, you may
use any value you like for the Student ID, as long as the IDs are unique to each
student. We recommend using something consistent and easy for students to
remember, such as a campus email alias or student ID. Do NOT recommend
students use anything that could be construed as particularly private (e.g. social
security numbers).
o If only a few students are having trouble with the web registration, you can always
use a combination of roll-call/in-class registration and Web-based registration. It may
be easiest to arrange an in class registration session for the few students who
inevitably have some trouble with the registration process.

still need assistance:

o Technical support is available via email at support@iclicker.com or toll free at 1-866-
209-5698. There is a live person on the line, and they are available 5 days a week,
9:00am-11:00pm Eastern, to answer questions.

o Training sessions are available daily. Visit https://iclicker.webex.com to register for a
training session. There is also extensive documentation available on our website,
http://www.iclicker.com.

Re-Registering a Student

If a student registers his/her remote incorrectly, you can easily correct these errors by directing the students to
simply re-register.

Whether or not you have already synchronized your roster, the step you must take to handle incorrect
registrations is the same: simply ask the students to register again using the correct information. When you
synchronize, the correct registration will automatically associate with the entry in your roster.

If you have synchronized and have more than a handful of students who entered the wrong student ID, and you
just want to start over:

1. Instruct all of the students to go to the iclicker.com site and register again using the correct student ID
(this only takes about 30 seconds per student).

2. Locate and OPEN the Session Data folder in the corresponding i>clicker course folder.

3. Locate and DELETE the RemotelD.csv file from the Session Data folder.

4. OPEN i>grader and SYNCHRONIZE again.

5. When you synch, the correct registrations will automatically associate with the entries in your roster.
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g TIP: You may want to hold off on synchronizing your roster until after the add/drop period as closed and
you have a new roster with current information (either your roster.txt file or your roster from Blackboard, WebCT,
etc.).

If you accidentally “accepted” an incorrect student registration during the web synchronization process (i.e. you
accidentally hit “accept” rather than “ignore” during the synchronization process), you will be alerted to this error
via a message from i>grader telling you that “Student X has participated in the following sessions with multiple
clickers (including the clicker numbers). This means that the student is registered to two different clickers and
used both clickers in the same session or sessions. To remedy this situation:

1. Contact the student affected to determine which clicker s/he is using.

2. Instruct the student(s) affected to re-register via www.iclicker.com using the correct information.

3. Open i>grader. Locate and click on the student’s name in i>grader. Select the clicker(s) that need(s) to be un-
registered and then select “Remove Clicker.” Select “Save” and your edit will be accepted.

Managing Your Add/Drops with your i>clicker roster

Adapting your i>clicker roster and i>grader gradebook to allow for students who drop your course:

1. Open i>grader, and click on the name of the student who has dropped the class (via the left-most column in
i>grader).

2. Highlight any registered clickers that the student has listed next to his/her name and then click the “Remove
Clicker” button. Repeat this process as needed (i.e. if a student is registered to more than one clicker). Write
down the clicker remote IDs you've just deleted.

3. Scroll down to the bottom of the student list in i>grader, and look for the clicker IDs that were just
unregistered. Click on the remote ID and then select “Delete Clicker Logs” in the pop-up window. IMPORTANT:
Make sure that you are deleting the dropped student’s clicker, and not any other unregistered clickers!

4. Close i>grader.

5. Remove the dropped student from your roster or gradebook. If using the “General” setting (i.e. you are not
using a course management system to record your i>clicker scores), open your roster.txt file and delete the
student from your roster. If you are using a course management system (e.g. Blackboard, Angel), delete your
old gradebook from your course folder and download a new copy from your CMS. This won't affect any of your
other students; they will all remain registered.

Adapting your i>clicker roster and i>grader gradebook to allow for students who add your course:

1. If you are using the “General“(non CMS or non-supported CMS), simply open the roster.txt file in any text
editor and add the new student’s last name, first name, and student ID to the bottom of the list.

2. If you are using a course management system (e.g. Blackboard, Angel, etc) delete your old gradebook from
your course folder and download a new copy from your CMS. This won't affect any of your other students; they
will all remain registered.

Have questions? Confused? Need help fixing your roster file? Need help navigating your
course management system? Contact us!
Our technical support staff is well-versed in all of the above and is available via email at
support@iclicker.com or toll free at 1-866-209-5698.
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